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Captivate 4, a product of Adobe Systems Incorporated, can be used to create video demonstrations and 
virtual guided tours, tutorials, and software simulations as well as online quizzes.  MS PowerPoint slides, 
including those in PPTX format, can be incorporated into Captivate 4 projects and synchronized with the 
original PowerPoint file using the linked import option.  Captivate movies can be embedded into Adobe 
PDF files, and variables can be used within interactive Captivate projects to personalize the user’s 
learning experience.  Captivate 4 can include text or voice-over that can be directly recorded or automatic 
voice-over converted from text.  Captivate is a great resource for creating tools designed to help students 
to explore their online learning environment, to gain necessary computer skills, to learn software, and to 
create tools for tutorials and testing.  We will explore the Captivate 4 environment in the guise of creating 
a video demonstration for accessing and using Blackboard’s virtual classroom. 
 
From the Adobe Captivate 4 page, http://www.adobe.com/products/captivate/, on the Adobe.com site, we 
can access information about Captivate 4 as well as new features information, 
http://www.adobe.com/products/captivate/features/?view=topnew, and the trial download page, 
http://www.adobe.com/go/trycaptivate.  Once we create an Adobe account, we can download and install 
Captivate 4 for a 30-day trial period; the list of Adobe product downloads is available at 
http://www.adobe.com/downloads/.   The Captivate 4 trial version converts to the full-featured version 
upon entering of a serial number after the purchase of the software. 
 

Figure 1:  The Captivate main menu. Figure 2:  The Create tab of the From Template entry  
in the New Project dialog box. 

 
Let us begin by examining the main Captivate menu, Figure 1.  There are five sections.  The first section 
on the top left displays a list of recent projects as well as an option for opening others and at the bottom 
of this section there is a hyperlink to the Adobe Captivate Exchange.  The Adobe Captivate Exchange, 
http://www.adobe.com/cfusion/exchange/index.cfm?event=productHome&exc=22, provides access to 
Captivate resources for purchase and exchange such as, for example, caption types and auto-text,  
project and design templates, games, media, playback controls, and sample projects.  The second 
section has subsections for creating a new project, creating a template, and for creating an aggregator 
project.  There are five (5) project types listed in the project subsection, software simulation, projects 
creates from a template, blank project, projects created from a MS PowerPoint, and image slideshows.  
Two types of templates can be created, a project template and a design template.  Design templates 
provide a standard look for projects as well as a set of custom visual properties for buttons, text captions, 
click boxes, highlight boxes, the mouse, question slides, quiz results slides, rollover captions, slides and 
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slidelets, text animations, and text entry boxes.  Project templates are useful in providing consistency 
among related projects or similar modules and, when multiple authors work together on a project, they 
allow project preferences to be used across multiple projects.  The aggregator allows one to combined 
multiple projects that have been published as SWF files and then publish the combined project as SWF 
output, an executable file, as a PDF file or as HTML.  The third section provides access to several 
tutorials that provide helpful examples and information about using and creating learning tools with 
Captivate.  Tutorial topics include recording, editing, publishing, quizzing, and interactivity and the last 
entry in this section provides direct access to the Community Help page on Adobe’s Captivate Help and 
Support site.  The first lower section provides access to the Adobe Captivate Developer Center, 
http://www.adobe.com/devnet/captivate/?trackingid=ZOGA, the Community Help page on the Adobe 
Captivate Help and Support site, http://www.adobe.com/support/captivate/?trackingid=ZOGB, and the 
Adobe Captivate Training page and the Adobe Captivate Exchange page, 
http://www.adobe.com/support/training/products/captivate.html?trackingid=ZOGC and 
http://www.adobe.com/cfusion/exchange/index.cfm?event=productHome&exc=22&loc=en_us&trackingid
=ZOGD, respectively.  The second lower section provides access to information about the Adobe 
eLearning suite, 
http://www.adobe.com/products/elearningsuite/?trackingid=EENEM&pss=cp_4.0_win_en_full___2004022
6.  So, this main menu/window provides access to all Captivate projects and templates as well as to 
helpful information and examples. 
 

Figure 3:  The Create tab of the Blank Project entry  
in the New Project dialog box. 

Figure 4:  The Create tab of the From MS PowerPoint entry  
in the New Project dialog box 

 
In the Create Project section, the Software Simulation, Blank Project, Image Slideshow, Project Template, 
and Design Template entries open the New Project dialog box.  The New Project dialog Box has two 
tabs, the Create tab and the Record tab.  Since the create tab lists options From Template, Blank Project, 
From PowerPoint, Image Slideshow, Project Template, and Design Template, we can change project 
types by selecting the desired project type in the left-window of the dialog box.  From the Create tab for 
the From Template entry, Figure 2, we can open the template that we want to use for a project.  For the 
 

Figure 5:  The Create tab of the Image Slideshow entry  
in the New Project dialog box. 

Figure 6:  The Create tab of the Project Template entry  
in the New Project dialog box. 
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Blank Project, Image Slideshow, and Project Template entries, we can select the size of the 
recording/capture window and/or the display method, for example full screen, Flash Player or Browser as 
well as Custom or Customize …, for the project using the Create Tab, Figure 3, Figure 5, and Figure 6, 
respectively; the pull-down menu for these options can be viewed in Figure 8.  The screen size is set in 
pixels. 
 

  
Figure 7:  The Create tab of the Design Template entry  

in the New Project dialog box. 
Figure 8:  The Select Size menu on the Create tab  

for the Blank Project, Image Slideshow,  
and Project Template entries. 

 
For the From MS PowerPoint entry on the Create tab, we can browse to find the MS PowerPoint file that 
we would like to import into our Captivate project, Figure 4, and the From Template entry on the Create 
tab, opens the Open dialog box to the Templates folder in Captivate, Figure 9, so that we can select the 
template that we want to use.  As with all applications, we should be careful to save all templates, both 
design templates and application templates, in the same main folder so that we can find them easily when 
we need them. 
 

 
Figure 9:  The Open Template dialog box. 

 
Using the Application entry on the Record tab, Figure 10, we select the window from which we would like 
to create our project.  Once the window has been selected, Figure 10, we can set the size of the 
recording rectangle.  The pull-down menu has the same size options as those in the Select Size menu on 
the Create tab, Figure 8.  In addition to the options on the pull-down menu, we can set the width and 
height directly as well as select the Application Region or the Application Window. 
 
The Screen Area entry on the Record tab of the New Project dialog box, Figure 12, contains options for 
setting the size of the recording rectangle; these include the same pull-down menu options as in the 
Application entry and on the Create tab, Figure 8.  Selecting the Custom option on the Recording 
Rectangle pull-down menu, Figure 13, changes the available screen options to full screen and custom 
size with direct entry of the width and height. 
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Figure 10: The Record tab in the New Project dialog box before 
the application window has been selected. 

Figure 11:  The Record tab in the New Project dialog box after 
the application window has been selected 

 
There is no perfect window size.  Creating several projects of different sizes and viewing them on 
computers with different screen sizes and screen settings will help you to decide the rectangle size that 
you prefer.  Overall, it is important to consider the window size and the position for the region to be 
recorded carefully.  There are a variety of screen sizes, laptops with diagonals of twelve inches of less, 
wide-screen laptops with diagonals of fifteen inches of more, and PC’s with large monitors having 
diagonals of eighteen inches or more, and, although most folks set their screen resolutions as 1024 pixels 
by 768 pixels or higher, there are still those who set their screen resolution as 800 pixels by 600 pixels.  
Selecting an appropriate window size makes it possible for the project, be it a video demonstration, 
tutorial, or quiz, to be viewed on any computer. 
 

Figure 12:  .The application, MS Internet Explorer, is selected 
for the Application entry on the Record tab of the New Project 

dialog box. 

Figure 13:  The dimensions of the recording rectangle are set 
on the Screen Area entry of the Record tab of the New Project 

dialog box. 
 
Since we want to create a video demonstration for accessing and using Blackboard’s virtual classroom, 
we select the Software Simulation entry in Create Project section of the main Captivate 4 window, select 
the MS Internet Explorer application (this must be open to the desired initial page on Blackboard) and set 
the recording rectangle to capture the application region rather than the application window in the 
Application entry on the Record tab, Figure 12, and set the desired size for the recording rectangle in the 
Screen Area entry on the Record tab, Figure 13.  Here, initially, we will use a custom setting of 750 pixels 
by 543 pixels, Figure 13.  Once the recording rectangle opens, we will be able to adjust its placement and 
size as needed. 
 
Setting the recording rectangle to record the application region rather than the application window allows 
us to set our recording region to a selected region rather than to the entire application window, Figure 14.  
We should consider the region that we want to display when choosing between recording the application 
region and the application window.  With panning, recording a selected region can help the user to focus 
on the information of interest as well as eliminate distractions that may be present in the application 
window.  In addition, the closer focus on the application region can make information easier to see than in 
the application widow. 
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We use the handles, the white rectangles displayed at the corners and in the middle of each side of the 
red recording rectangle, to adjust the size of the recording rectangle.  Positioning the cursor over the red 

recording rectangle turns the white arrow cursor, , into the black four headed arrow cursor,  , which 
can be used to move the recording rectangle to a different position in the application window.  Comparing 
Figure 14 with Figure 15, we see that the location and width of the recording rectangle have been 
adjusted so that the Blackboard menu at the left-hand side of the window and the Join and Recordings  
 

 
Figure 14:  The recording rectangle displayed over the  

MS Internet Explorer window in its initial position  
and initial size, 750 pixels by 543 pixels. 

 
buttons on the Collaboration Sessions page will be displayed within the recording rectangle; the width of 
the rectangle has been increased to 850 pixels.  Before beginning the recording, we should always make 
sure that the desired elements will be included within the recording rectangle. 
 

 
Figure 15:  The recording rectangle displayed over the  

MS Internet Explorer window – resized to 850 pixels by 543 pixels  
and adjusted to display the desired region . 
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To do this, we can open the recording rectangle and step through the movements that we want to make 
and the parts f the pages that we want to display.  Since the recording rectangle remains on top of all 
windows displayed on screen until recording is completed or cancelled, we can check the view of the 
pages and entries to be displayed. 
 
 

      
Figure 16:  The recording control buttons. Figure 17:  The Automatic Recording settings. 

 
 
The size of the recording rectangle is displayed at the top right-hand corner of the rectangle and the 
recording controls, Figure 16, are displayed vertically along the top left-hand side of the rectangle.  The 

first recording control,  is used to begin recording in the selected mode.  The automatic recording 

mode can be changed using the second control, .  The third control button, , is used to select the 

options for the full motion recording mode.   is used to set the options for the manual recording mode.  

The last button, , is used to cancel the recording. 

Left-clicking  opens the Automatic Recordings settings dialog box, Figure 17, left-clicking  opens 

the Full Motion Recording settings dialog box, Figure 18, and left-clicking , opens the Manual 
Recording settings dialog box, Figure 19.  In each of these, we can set the panning option     (no panning, 
automatic  
 
 

  
Figure 18:  The Full Motion Recording settings. Figure 19:  The Manual Recording settings. 

 
 
panning, or manual panning), the audio option (no narration, stereo mix, microphone, or CD player) and 
the general settings for the project (using the Settings … button).  The Advanced option in the Automatic 
Recording dialog box opens the language options for the Captions. 
 
Left-clicking the Settings … button opens the Preferences dialog box. 
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Figure 20:  The General Settings. Figure 21:  The Default settings. 
 
The General settings entry, Figure 20, in the Global settings can be used to change file location to which 
projects are published, the grid size, to change the spelling preferences and confirmation messages 
preferences, the rescaling of imported/pasted slides preference, the generation of project backup 
preference, and the display of the welcome screen preference.  The timings for the various elements of 
the project, including the slide duration, timing of the text caption, mouse, highlight box, rollover effects, 
buttons, and animation, for example, can be set using the Defaults entry in the Global Category, Figure 
21; the defaults can be restored for selected objects or for all objects using the Restore selected and 
Restore all buttons, respectively. 
 

Figure 22:  The Recording Settings.. Figure 23:  The Full Motion Recording options. 
 
The Recording Settings, Figure 22, include options for narration, camera sounds when screen captures 
are taken, keyboard tap sounds for keystrokes, hiding the system tray icon, moving new windows within  
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Figure 24:  The Recording Keys. Figure 25:  The Recording Modes. 
 
the recording region, capturing interim screen shots, and automatically using full motion for drag-and-drop 
motion and mouse wheel actions.  The Full Motion Recording options include showing the mouse, 
selecting the working folder, and the video color mode, Figure 23. 
 

 
Figure 26:  The Recording Defaults. 

 
The Recording Keys, Figure 24, serve as the controls while recording.  These include general controls 
such as the End key to stop recording, the Pause key to pause and resume recording, and the F8 key to 
resume re-recording, the Print Screen key for manual screen captures as well as controls for full motion 
recording and panning.  The settings for adding captions, showing the mouse and mouse movement and 
adding highlight boxes are controlled using the Recording modes, Figure 25.  The colors and settings for 
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text captions and highlight boxes as well as for success, failure, and hint captions are controlled using the 
Recording defaults, Figure 26. 
 
With all our settings adjusted as desired, we are ready to record out project.  We use the first recording 

control button, , to begin recording our project.  Captivate will take a screen capture when we click on 
any buttons or hyperlinks as well as when the screen changes.  Since the display of new windows can be 
delayed due to the connection speed, we can use the Print Screen button to add screen captures when 
desired/needed; adding screen captures is not problematic since the corresponding slide in the project 
can be easily deleted when we edit the project. 
 

 
Figure 27:  The Recording Rectangle displayed over the project window. 

 
When we begin our project, the recording control buttons, Figure 16, disappear:  the recording proceeds 
with the region inside the recording window being captured with each mouse click or screen change.  
Since there are no controls displayed on the screen, Figure 27, it is important to take note of the 
Recording Keys, Figure 24.  While you can change the Recording Keys, the logical correspondence of 
the Pause, End, and Print Screen to their name-sake functions is beneficial to maintain for easy use. 
 

 
Figure 28:  The Save Project Files dialog box. 
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Once we have completed the desired movements, we press the End key to conclude recording.  The 
Save Project Files dialog box, Figure 28, opens.  Using the Save Project Files dialog box, we name the 
project, and select the location to which to save the project using the Browse … button.  It is important to 
save projects to a location at which the files are easy to find as well as to use a project name that will 
make it easy to distinguish between similar projects.  Saving all elements of a project in a main folder as 
well as grouping related projects within other folders makes it easier to find and to modify projects; 
organizing projects within folders makes them easier to find when making an aggregator project. 
 
Once the project has been saved, the project opens in the Storyboard View, Figure 29. The Storyboard 
View allows us to examine all the project slides together.  The Edit View, Figure 30, allows us to examine 
and to edit individual slides.  
 

 
Figure 29: The Storyboard View for our project. 

 
The base Edit View, Figure 30, allows us to examine the individual slides in a manner similar to that used 
in MS PowerPoint.  However, it is helpful to be able to view the timings for the slides while editing the 
slides. 
 

 
Figure 30:  The Edit View for our project. 
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In order to display the slide timings Timeline as well as to display additional toolbars, we use the Window 
menu, Figure 33.  Left-clicking the Timeline entry on the Window menu displays the slide Timeline at the 
bottom of the Edit View window, Figure 31.  Positioning the cursor over the four vertical dots at the left 
end of the Timeline for Slide 1 bar, left-clicking, holding, and dragging, we can move the Timeline from 
the bottom to the top of the editing window below the menus and toolbars, Figure 32.  Customizing the 
Captivate windows so that frequently used elements are positioned to make them easy to access/use 
makes the Captivate environment more comfortable and easier to use when working on projects.   
 
Examining the Slide menu, Figure 34, for example, we see that there are many aspects of the project that 
we can customize including the mouse pointers, the slide transition, the video quality, slide properties, the  
 

 
Figure 31:  The Storyboard View with the slide Timeline displayed at the bottom 

of the project window. 
 
pointer path on the slide, standardizing the pointers for all slides, and even lock the slide.  As with MS 
PowerPoint slides, we need to be careful not to make our projects overly-busy (let’s be honest – irritating) 
by adding frivolous elements. 
 

 
Figure 32:  The Storyboard View with the slide Timeline displayed at the top of 

the project window. 
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Using the Branching View, we can view and edit the branching options for a project.  Examining the 
Branching view for our project, Figure 35, we do not find any branches:  our project was recorded in a 
linear manner, moving from one page to the next within the Blackboard site.  The individual branches of a 
project must be recorded/created before they can be added as branches off individual slides.  When we 
record the original project, we can record the various parts that we want to use as the branches and then 
edit these to become the branches of the project.  The advantage to recording all parts of the project at 
the same time, with the same settings, and in the same window is consistency of the view of the project.  
Branches provide interactive elements in demonstrations and tutorials that enable the user to jump to 
other slides, to view selected URL’s, and to open other projects.   
 
Up to this point, we have not discussed adding audio to projects.  While we can add narration as we 
capture images, it is more efficient to add audio after the visual aspects of the project have been collected  
 

 
Figure 33:  The Window menu. Figure 34:  The Slide menu. 

 
and edited.  Using a computer’s built-in microphone does not provide the best sound.  Sound levels can 
be modified but the best sound recording is done using an external microphone.  In order to avoid 
recording extra sounds due to movement of the microphone, it is best to place the microphone in a stand 
and to eliminate as much background noise as possible during the recording session.  Creating a script 
for the narration and practicing is helpful.  Using a script helps us to consider what we want to say, and 
practicing helps us to consider the speed at which the narrative should be read and the tone to be used 
during recording so that the audio is pleasing rather than grating.  Even if audio is to be added to a 
demonstration, it is important to include text boxes. 
 
We must carefully consider the needs of the user:  audio is beneficial to some learners, and visual 
elements and text elements are important to others.  While using background music may be tempting, the 
user may not appreciate/like the background music that we select.  In addition, background music can 
distract the user from important details that the tool is meant to communicate.   
 
Captivate 4 has an automatic voice-over function with which closed caption text can be converted to 
speech using installed voices.  This text-to-speech conversion eliminates the need to purchase audio 
equipment for recording audio. 
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Figure 35:  The Branching View for our project. 

 
It is important to carefully consider how text captions will be displayed on slides.  For example, text 
captions with a transparent background, Figure 36, can be difficult to read even when larger text is used. 
 

 
Figure 36:  The slide with transparent text caption.. 

 
However, text captions within callouts with nontransparent backgrounds make reading the text easier; the 
color options for text captions are set in the Recording Defaults, Figure 26.  Left-clicking the text caption 
and selecting Properties on the Edit menu or right-clicking the text caption and selecting Properties on the 
pop-up menu opens the Text Caption dialog box, Figure 38.  Using the Text Caption tab, we can edit the 
text and formatting for the text caption as well as select the caption type and colors.  There is a limited 
number of symbols that can be included in captions as well; to access these symbols, we would left-click 

the  button on the toolbar in the Text Caption window. 
 
Text within captions can be directly edited by left-clicking the text:  this places the caption in an edit mode 
in which the text within the caption can be modified.  If more than the text for a caption is being modified 
then using the Properties entry on the Edit menu or on the right-click-pop-up menu to display the Text 
Caption dialog box is more efficient.  The Text Caption dialog box opens when we double-click the 
caption’s element in the slide Timeline. 
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Figure 37:  The slide with text caption within a callout. 

 
We must be careful to use readable and available fonts.  Unreadable text within captions are not helpful 
to the user.  If we select a font that is not available on the user’s computer then another font will be 
substituted:  the font that is substituted may be unreadable using the size, color, and formats that have 
been set for the caption.  While varying colors and fonts can be tempting, using a common color scheme 
makes elements easy to find on the screen.  We must also be careful of color contrast and colorblindness 
since we want our project to be useful for everyone.  You may find it helpful to read about color contrast, 
http://www.lighthouse.org/accessibility/effective-color-contrast, and colorblindness, 
http://colorvisiontesting.com/ and http://www.visibone.com/colorblind/.   
 

 
Figure 38:  The Text Caption dialog box. 

 
We can modify the display timings for each element individually using the Options tab on the element’s 
editing dialog box, for example the Text Caption dialog box in Figure 38, or we can use the visual 
representation of the timing the elements on the slide provided in the Timeline.  Each element can be 
modified by clicking and dragging as well as positioning the cursor at the beginning or the end of the 
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Figure 39:  The unedited Timeline elements.. Figure 40:  The edited Timeline elements. 

 
element so that the cursor becomes the double headed black arrow and left-clicking and dragging it to the 
desired duration measured along the Timeline ruler.  The elements can be dragged to the desired starting 
time and the slide’s overall duration can be controlled in the same manner as well.  When setting the 
timing for text elements it is important to make sure that the user has time during which to read the text; it 
is always best to err on the side of the slower reader.  The slide elements can be modified to extend the 
display time as well as to modify when each element is displayed.  Grouping elements in the Timeline 
makes it easier to visualize how they are displayed, and left-clicking the Preview button on the Edit View 
toolbar allows us to preview individual slides as well as the whole project, the next five slides and the 
slides from the selected slide to the end of the project. 
 

 
Figure 41:  The Publish dialog box. 

 
With the completion of editing of visual, audio, timing, and branching aspects of a project, we are ready to 
publish our project.  Several publishing options are available including Flash, Adobe Acrobat Connect 
Pro, stand alone executable files, and creating a MS Word document for the project; Captivate can send 
files by email and send files to websites via ftp.  The Flash version of the project can then be used in a 
website and directly launched in the browser window.  Captivate 4 has four Flash version options, Flash 
7, Flash 8, Flash 9, and Flash 10.  Since the version of Flash Player must be selected when the Flash 
version of the project is created, users who need to update their version of Flash Player will appreciate 
the posting of update instructions and a download hyperlink with the project; publishing the project to an 
earlier version of Flash may be easier if the users are less computer savvy. 
 
One particularly nice aspect of Captivate 4 is that it can be installed without uninstalling Captivate 3.  So, 
if there are aspects of each version that we like, hard drive space permitting, we can keep and use both 
versions. 
 
I hope that you found this handout helpful. I have tried to provide enough information to help you to get 
started without your feeling overwhelmed. The best way in which to learn how to use new software is to 
"mess around" with it.  Explore the help facility, explore the keywords, make some test projects, explore 
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the different aspects of the slide elements, test the different ways in which to save the project and test 
how the project displays and runs on different computers.  As you explore Captivate 4, remember to save 
the projects that you make so that you can compare them and refer to them in the future -- we learn 
through trial and error, and we can learn a lot from our mistakes. 
 
Please feel free to contact me, smabrouk@framingham.edu, if you have any questions – I am always 
glad to help. 
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